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Power System Simulation for Engineers (PSS/E version 33) 

 
Here are instructions for accessing and using the PSS/E-33 software. On-campus students should 
access this software at any of the computers in the lab of Coover room 1125. 
 
Make sure that you quit the program when you are no longer using it. Otherwise it uses up one of 
the 20 users and someone else may not be able to get to it. 
 

1. Log on to your computers. You can find this software. 
a. Go to C:\Program Files(x86)\PTI\PSSE33\PSSBIN and Click on the “psse33.exe” 

icon. (An icon with a white background) 
b. Start  All Programs  Siemens PTI  PSSE 33 PSSE®E 33. 

 
2. To view already existing cases - Go to FileOpen. You will get a list of already 

existing cases. Select any case that you would wish to view. These files have the 
extension “.sav”. (There are lots of other files with different extensions. Do not open 
those. You might want to use those at a later stage) 

 
3. To create a new file, Click – FileNew. A small dialog box with five option buttons 

will be opened. Select the option “Network Case” and click OK. 
 

4. This will open a “Build New Case” dialog box. Set the “Base MVA” as “100.00”. Then 
there will be two blank spaces corresponding to Heading line 1 and heading line 2. Input 
“EE 303 PROJECT” in the heading line 1, and your name in the heading line 2, 
then Click OK. 

 
5. This will get you to the spreadsheet interface, where you are going to build your new 

case. 
 

6. Now you can start modeling a power system. To build a case you need the following 
information: 

 
a. Bus Data: 

1) Base KV. It is required that you have the data about bus “Base KV” for every 
bus. 

2) You must also know the type of the buses. i.e., whether it is a swing bus (one 
of the buses having a generator, for which you designate voltage magnitude 
and angle), or a PV bus (buses having a generator but not designated as the 
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swing bus, for which you designate real power and voltage magnitude), or a PQ 
bus (generally a load bus, but sometimes not: it is a bus for which you 
designate both real and reactive power; such a bus may or may not have load 
and for such a bus the real and reactive power is designated as 0,0). 

 
b. Branch Data (Transmission lines): 

1) “From” bus and “To” bus numbers. 
2) R, X, and Line charging values in per unit. 

 
c. Load Data: 

1) The “Bus number” to which it is connected. 
2) P (in MW) and Q (MVAR) of the load. 

 
d. Generator Data:  

1) The “Bus number” to which it is connected. 
2) Generator Real Power Rating (in MW). Maximum and minimum limits for 

reactive power (in MVAr) 
 

e. Transformer Data:1 
“From” bus and “To” bus numbers 
 

7. Once you are done with entering all the data for the power system modeling, you can 
save this case file. Remember to save the file very often, so that you do not lose the data 
you have entered. 

 
8. To save, Click FileSave from the File menu. This will open a “Save / Show network 

data” dialog box. This dialog box will have a lot of Tabs on the top. You may select the 
“Case Data” tab. Under this tab there is a text box meant to enter your file’s destination. 
You may click on the box that is on the right-hand side of this text box, with 3 dots on it 
to select your destination. Make sure you save it on your U: drive and not at a default 
location that maybe on the computer’s C: drive. Before storing there, give a suitable 
filename to your case, e.g., “psseflow” etc. After entering a suitable filename, you should 
click “OPEN”. This will show the destination of your new file in the “Destination” text 
box of the “Save network data” dialog box. Now click on OK. 
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Building a case in PSS/E: 
 
This is illustrated with an example. Consider the power system diagram shown below. 
 

 
 
This power system has 6 Buses, 2 generating units connected, 2 transformers, 2 loads, and 5 
transmission lines. Our objective is to model this power system using PSS/E, and thereby we can 
conduct many studies on this network using the simulation facilities of PSS/E. 
 
When you create a new case using the FileNew command, you will get a spreadsheet interface. 
You will find a lot of Tabs at the bottom of this spread sheet view, which corresponds to “Area”, 
“Buses”, “Branches”, “FACTS”, etc. Among those the tabs that we use are: (follow the same 
order while creating the case): 

1. Buses 
2. Branches 
3. Loads 
4. Machines 
5. Plants 
6. 2- Winding Transformer 
7. Areas 
8. Zones 
9. Owners 

The last three are optional. For the sake of completion we can fill those three spreadsheets too. 
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1. Bus Data: 
 
The spread sheet corresponding to “Buses” will have many columns in which you are required to 
enter the data corresponding to every bus in the system. You need not enter all the data, but only 
the data that are mandatory. Others will have some default values that the software assumes while 
solving the Power Flow case. 
 

a. Give every bus a “Bus Number”. Follow the numbering that is given in the diagram. 
b. Give the “Bus Names” as you wish. You must type the names within single quotes. Ex. 

‘BUS1’ etc. 
c. Enter the “Bus KV” in the 3rd column. The nominal KV for buses 1 and 2 are 13.8 KV, 

and for the remaining 4 buses it is 69 KV. 
d. Once you enter the KV values, you can enter the “Area Number/Name” to which the 

bus belongs. This is of very great significance when it comes to a very large system. 
Here you can model everything in a single area. So you can fill 1 under the “Area 
Number/Name” column and leave name blank for every bus. 

e. You can also model everything in a single “Zone Number/Name”. You may assign it 
as 1 for every bus. (Dividing the whole network into different areas or zones is at the 
discretion of the individual modeling the system.) You need not fill the zone name. 

f. You can also model everything in a single “Owner Number/Name”. You may just fill 
1 here. You need not fill in the owner name. 

g. Once you have entered the above data, you may leave the rest of the columns free. They 
will take their default values. 

 
For example: Consider the Bus # 1 
 
Bus Number  Bus Name  Base KV  Area Number/Name   Zone Number/Name   Owner Number/Name 

      1              ‘Bus1’      13.8                    1                             1                                1 
 
After filling these you must not press “Enter” to move to the next row, but you should just click 
on the bottom row to enter the next bus data. Now fill in the same way for the rest of the buses 
(from 2 to 6). So in this way you will fill in these data for every bus in successive rows. If you 
want to make any change to the already entered values, make the change by clicking on the 
respective cell. After making the change, click on some other row to record the change, i.e., 
while changing the data, you will see a pencil mark at the left-hand corner of the row. Once 
you have finished changing, click on any other row so that the pencil mark vanishes, 
signifying that your change has been recorded or activated. 
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Once you are done with entering all the bus data, now you can move to the spreadsheet 
corresponding to the “Branch”, by selecting the “Branch” tab at the bottom of the spreadsheet 
view. 
 
2. Branch Data: 
 
This spreadsheet corresponds to the transmission lines data. 
 

a. Now fill in the “From Bus” number in the first column, and the “To Bus” number in the 
3rd column. 

b. Leave the Columns corresponding to “From” and “To” Bus names (Col 2 and Col 4) free. 
PSS/E will read it from the “Buses” spreadsheet automatically. 

c. Give “Id” to every branch. This can be a mere number or can also be an alphanumeric 
value, having length of 2 characters. Assign it as 1. 

d. Then fill in the successive columns with the R, X, and Charging data. All in per unit. 
e. The status of all the braches shall be “In Service” to start with. (Later we will want to 

disable one of these lines, i.e., we will want to simulate the outage or removal of a 
line.) 

f. You need not fill in any other columns. 
 
Follow this procedure for every branch. Enter all these data for the first branch, and then go to the 
next row to enter data for the second. Do this for every branch in successive rows. The data for all 
branches are R=1 ohm, X=10 ohm, and B=0.002 mho. You must find the per unit values for R, 
X, and the line charging susceptance, B. Note that the “Charging” is the total susceptance for the 
line (do not divide by 2). 

 
For example: (Per-unit values in this example are sample data and are not related to our system) 
 
From Bus#   From Bus   To Bus#   To Bus   Id    Line R    Line X    Charging (pu)    In Service 

 Name                      Name             (pu)         (pu) 
4                                   5                          1     0.01        0.354          0.0895               Tick 
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Hence, fill in all the data for every transmission branch like this. After filling data in this 
spreadsheet, now we will go to “Load” spreadsheet, by clicking on the “Load” Tab.  
 
3. Load Data: 
 

a. Enter the “Bus Number” to which the load is connected. You need not enter anything for 
the “Bus Name” column. 

b. Give this load an “Id” in the 3rd column. Assign it as 1. 
c. Follow the same instructions for filling out the Area, Zone, and the Owner numbers as 

you had done for the “Buses” spreadsheet. 
d. Check the “In Service”. (Not checking means there is no load present. This can be done 

later for further studies). 
e. Enter the values for the “Pload (MW)” and “Qload (MVAr)” in the next two columns. 

The loads connected to the buses 5 and 6 are of the same levels, i.e., 40MVA@ 0.85 pf 
lagging. 

f. You need not fill the rest of the columns. Now click on the row below, and enter data for 
the next load. Do this for all the loads present. Do not forget to click on the row below 
after you finish entering data for any Load (so that it will get recorded). 

 
Example: (Load values in this example are not our system load’s values. They are sample data) 
Bus#    Bus name   Id    Area# /Name    Zone#/Name.  Owner#/Name.  In Service  Pload(MW)  Qload(MW) 

5                         1             1                     1                      1               Tick           23               32 
 
Once we are done entering all the load data, now we can enter the Generator data in “Plant” 
spreadsheet by clicking on the “Plant” tab. 
 
4. Generator Data: 
 
In the “Plant” spreadsheet, all you need to do is to make a list of all existing generators. Here is 
how to do this: 

a. Fill in the “Bus Number” to which the generator has been connected. You need not fill 
data in any of the other columns. 

b. Now click on the next row to fill in the data (Bus Number) for the next generator. Do this 
for all the generators. In this case, we have only 2 generators. 

 
Once you have created a list of generators in the “Plant” Spreadsheet, Now you may go to 
“Machine” Spreadsheet, by clicking on “Machine” tab. Here again you are going to enter the 
data corresponding to every generators. 



 7 

 
 

a. Enter the “Bus Number” to which the generator has been connected. You need not fill in 
the “Bus Name” column. 

b. Give an “Id” for the generator in the 3rd column. Assign it as 1. 
c. Check the “In Service”, if you desire the generator to be in action. (Check it at the 

beginning). 
d. Then fill in the Pgen (MW) value, Qmax (MVAR) and Qmin (MVAR) values. You 

need not fill the remaining columns. They will take their default values. 
 
Generator Data: 
 
Generator      Pgen(MW)       Qmax(MVAR)        Qmin(MVAR) 
1                       80                     50                               -30 
2                       40                     50                               -30 
 
Example: 
Bus#  Bus Name  Id   Code  Status   Pgen(MW)  Pmax  Pmin  Qgen  Qmax(MVAR)  Qmin(MVAR) 

5                        1      1      Tick     80                                               50                     -30 
 
Once you are done entering data into the “Machine” spreadsheet, select the “2 Winding” tab to 
enter the data for the transformers.Trans1 
 
5. Transformer data 
 

a. This is very similar to that of entering the branch data. Enter the “From Bus Number” 
and “To Bus Number” in column 1 and 3 respectively. You may again leave the columns 
corresponding to their names free. 

b. Give an “Id” for the Transformer in the next column. Assign it as 1. 
c. Give a “Name” for the transformer within single quotes, e.g., ‘Trans1’ etc. 
d. Check the “In Service”. 
e. Then go to column “Impedance I/O code”, leaving a few columns free in the middle. 
f. Select “Zpu (system base)” from the drop down list box. 
g. Then select “Ypu (system base)” from the drop down list box in the next column. 
h. Then fill in the data for “X (pu)” in the respective column. Make transformer impedance 

to be 5% per-unit for both transformers 
i. Then enter “100” in the column named “Rate A” for both the transformers. The remaining 

columns need not be filled. They will assume their default values. 
 
This procedure should be followed for all the transformers in the system. In our example, we have 
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only two transformers: one is connected between buses 1 and 3 and another connected between 
buses 2 and 4. 
 
Example: 
From Bus# ….To Bus…  Id  Name  In Service     Impedance      Admittance         R           X (pu)                                                            
 

1                      3          1     ‘ T1’      Tick    Zpu(sys base)    Ypu(sys base)   default        0.05 
Default means, Leave it free, as no data is given for R and X values of the transformers. 
 
6. Bus Codes: Once you have entered the data for all the transformers in the system, now you 

have to again open the Spreadsheet corresponding to the “Bus”. 
 
In the “Buses” spreadsheet, go to the column named “Code”. In that, you have to enter the code 
for every bus. 
 
Bus Type      Code 
Swing Bus (any one Gen Bus)               3 (Make it bus #1) 
PV buses (generator buses)   2 (bus #2) 
PQ buses (Load Buses)    1 (remaining buses) 
After entering all codes, now open the “Area” spreadsheet by clicking the “Area” tab. 
 
7. Area Data: 
 

a. Enter the “Area Number”. 
b. Enter the “Area Swing bus Number”. (Make sure the bus number that you are entering 

has a generator connected to it). In our case, it is BUS # 1. 
c. Give the area a “Name” in the last column. You need not enter any other data here. 

Example: 
Area #     Area Swing Bus #     Desired Interchange     Tolerance (MW)    Area Name 

1              1                                                      ‘ABCD’ 
After entering the area data, you may enter the data for “Zone” by clicking on the “Zone” Tab. 
 
8. Zone Data: 

Enter the “Zone Number”, and the “Zone Name”. 
 

Example: “Zone” Spreadsheet looks like this 
Zone Number    Zone Name 

1                 ‘Zone1’ 
After this, now you may enter the owner details. Go to “Owner” spreadsheet by clicking the 
“Owner” tab. 
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9. Owner Data: 

Enter “Owner Number” and “Name”(within single quotes) 
After all these are data entered, you are now ready to run the power flow. 
 
To Run the Power Flow: 
 
1. Click the menu Power FlowSolutionSolve (NSOL / FNSL…………….) 
 
2. This will open a “Loadflow Solutions” dialog box. You may just click “Solve” to solve the 

case. Your result will be available in the bottom most window called the “Progress” window. 
 
3. You can run the power flow using different algorithms. This can be done by changing the 

option in the “Loadflow Solutions” dialog box before clicking OK. (The methods include 
Newton Raphson, Gauss-Siedel, etc.) 

 
4. You may also view the report by clicking Power FlowReports. Under that there are 

different kinds of reports that one can generate, based on the area, zones, or the entire 
network. You will see the report on the bottom most part of the PSS/E window, on the same 
place where the “progress” tab is. 

 
5. You can see the diagrammatic view of any “Bus” by just going to the “Buses” spreadsheet, 

and then selecting the row corresponding to that bus whose diagram you want to view and 
then right clicking on it will open a list of commands. You may click the command “Create 
Bus Display” to see the diagrammatic representation of the power flow result corresponding 
to that particular bus. You can also get the entire system diagram by following the steps 
described in Appendix A. 

 
To print the power flow report, go into the bottom window and right click and select Print. The 
report should be printed landscape instead of portrait, and may not print correctly if sent directly 
to the printer – watch the right-hand part of the page to see that nothing is cut off (often the right 
four columns of the output are cut off). 
 
It is suggested that on the Print dialog box you select “CutePDF Writer” or “AdobePDF” in 
Coover 1125. Chick on the “Properties” button and select “Landscape” under the Layout tab. The 
PDF file will show up in an icon along the bottom edge of the screen – click on it. You may be 
able to print it now without loss of columns or you may want to save it to your U: drive -  do a 
“Save As” and select the folder on your U: drive and a file name. 
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Answer the following questions: 
 

a. Compute the system’s admittance matrix element Y33. 
 

b. What is the generation at buses 1 and 2? 
 

c. You should find that the numerical value of the bus 2 generation is a whole number, but 
that of bus 1 is not. Why is this? 

 
d. Does the sum of the real power generation equal to the sum of the real power load? 

Explain. 
 

e. What are the p.u voltage magnitudes of buses 1 and 2? Why? 
 

f. Are the bus 1 and 2 generators regulating? In other words, are their reactive generation 
levels within the physical limitations of the generator? 

 
g. Which two buses have the lowest pu voltage magnitude? Explain. 

 
h. Does any bus have a higher pu voltage than the generator (source) buses? Explain. 

 
i. Which line has the largest angular separation across it? Why? 

 
j. Compute the line charging current at bus 5 associated with line 3-5. Also calculate the 

reactive power supplied by this line charging capacitance at bus 5 (refer to the π-
equivalent line representation). 

 
k. Calculate the current I34 in the line 3-4. Using the voltage at bus 3 (from the power flow), 

calculate P34 and Q34. Check your answers with the power flow solution of PSS/E. (you 
can get these values from the PSS/E power flow reports) 

 
l. Calculate the approximate values of P34 and Q34 using the equations T1.20 & T1.22 for 

P, and T1.21 & T1.23 for Q from the course notes. Verify this with simulation. 
 

m. Check the voltage magnitude at each bus. Make sure they are all above 0.98pu. If not, try 
to add a fixed capacitor at that bus. (Note: because of the cost issue, the MVar value of the 
fixed capacitor cannot be larger than the reactive power load at that bus.). Express the 
capacitance that you find in both [F] and [MVAR]. Print out the power flow report. 
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n. Increase the load at bus 6 to 68 MW and 42MVar. Check the voltage magnitudes again. If 
there is any below 0.98pu, try to resolve this issue by adding capacitors to the system. 
You have to decide which bus to connect the capacitance. Explain why adding capacitors 
can increase the voltage magnitude through specific power flow calculations. Print out the 
power flow report. 
 

o. Change the voltage magnitude at swing bus from 1.0 pu to 1.01 pu. Report what happens 
to the voltage magnitudes at other buses. 

 
p. Identify the maximum loading values at bus 5 and 6 by following the steps described 

in Appendix B. Plot bus 5 voltage magnitude against total bus 5 + bus 6 real power 
load. Study T1.6.2 p.69 of class notes. (BONUS) 

 
 
Each student should turn in a report due on Thursday 12/8 with 
 An entire system diagram as described in Appendix A. 
 A Print-out of the Power Flow Report under the "normal" loading conditions. 
 A Print-out of the Power Flow Report for problem m 
 A Print-out of the Power Flow Report for problem n. 
 Answers to the above questions. 
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Appendix A 
 
How to create the entire system diagram in PSS/E: 
 
After solving the case you have built, the entire system diagram can be obtained by the following 
steps: 
1. Click - File→New. A small dialog box with five option buttons will be opened. Select the 

option “Diagram” and click OK. This will get you to the diagram interface where you are 
going to build your system diagram. 

2. Click “Auto Draw” button (    ))) in the toolbar and there will be the cross cursor in the 
interface. Now click on the blank area and this will open a “Select Bus” dialog box. You may 
click the box named “Select…” and this will open another “Bus Selection” dialog box. You 
may choose any bus that you have already built in the left part of this dialog box and then 
click OK. Now in the “Select Bus” dialog box the bus number which you just chose appears 
in the text box. Click OK. 

3. Now the diagram related to the chosen bus shows in the interface. 
4. To adjust the position of the diagram, click “Select” button (    ) in)the toolbar or press “Esc” 

on the keyboard and then you can make adjustment in the interface.  
5. You get all the connections related to every bus by repeating the steps 2 to 4. Finally you get 

the whole system diagram as shown below. 
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Appendix B 
 
This test is done by repetitively increasing the load at the buses 5 and 6 and running the power 
flow. Each time, make the increase in relatively small increments, say 20% (multiply by 1.2) for 
the real power (and 20% for the reactive power so that tanθ=Q/P remains constant). Continue 
doing this until the power flow program diverges.  
For each converged solution, record the voltage magnitude at bus 5 and the total real power at 
buses 5 and 6. When you get a case that diverges, then return to the last converged case and 
increase by 10%.  

• If it converges, increase by 5% 

• If it diverges, go back to last case that converged and increase by 5%. 

Use the simulation results to plot PV curve in a software of your choice.    
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